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ВИКОРИСТАННЯ ПАКЕТУ R ДЛЯ КОМП'ЮТЕРНОГО МОДЕЛЮВАННЯ 

КОНТАКТІВ АНТИГЕНІВ З АНТИТІЛАМИ В КІБЕРФІЗИЧНИХ 
ІМУНОСЕНСОРНИХ СИСТЕМАХ НА ПРЯМОКУТНІЙ РЕШІТЦІ  

 
В роботі проведено комп’ютерне моделювання контактів антигенів з антитілами в кіберфізичних 

імуносенсорних системах на прямокутній решітці з використанням диференціальних рівнянь із запізненням за 
допомогою пакета R. Предметом дослідження є кіберфізична імуносенсорна система на прямокутній решітці з 
використанням диференціальних рівнянь із запізненням. Метою роботи є дослідження контактів антигенів з 
антитілами кіберфізичної імуносенсорної системи на прямокутній решітці з використанням диференціальних 
рівнянь із запізненням за допомогою пакета R. Реалізовано комп’ютерну програму «Комп'ютерне моделювання 
контактів антигенів з антитілами в кіберфізичних імуносенсорних системах на прямокутній решітці з 
використанням диференціальних рівнянь із запізненням». Проведено комп’ютерне моделювання досліджуваної 
моделі, наведено параметри моделі, їх числові значення, а також представлено параметри в пакеті R. 
Проаналізовано останні дослідження в галузі імуносенсорів, їх видів, та популярність наукових напрямів 
дослідження, протягом останніх років. Незважаючи на величезну різноманітність сучасних фізико-хімічних 
методів детектування аналітичного сигналу в імуноаналізі найбільш широко використовуються електрохімічні 
методи, які мають низку незаперечних переваг: висока чутливість і точність, селективність і експресність, 
невисока собівартість та універсальність. Описано пакет R як середовище програмування для статистичного 
аналізу даних із заданими значеннями параметрів моделі імуносенсора на прямокутній решітці з використанням 
диференціальних рівнянь із запізненням. Наведені посилання на корисні сайти та рекомендації по роботі з 
пакетом R. Результати чисельного моделювання контактів антигенів з антитілами в кіберфізичних 
імуносенсорних системах на прямокутній решітці з використанням диференціальних рівнянь із запізненням 
дають змогу провести дослідження стійкості моделі імуносенсора. Встановлено, що її якісна поведінка суттєво 
залежить від часу запізнення. 

Ключові слова: кіберфізична система, біосенсор, імуносенсор, математична модель, диференціальні 
рівняння, пакет R. 
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THE USE OF R-PACKAGE R FOR COMPUTER MODELLING OF ANTIGEN CONTACT CONTENTS WITH 
ANTIBODIES IN CYBER-PHYSICAL IMMUNOSENSOR SYSTEMS ON THE RECTANGLE LATTICE  

 
The computer modelling of contacts of antigens with antibodies in cyberphysical immunosensory systems on a rectangular lattice 

using delayed differential equations with the help of the package is carried out in the work. The subject of the study is a cyberphysical 
immunosensory system on a rectangular lattice using delayed differential equations. The purpose of this work is to study the contacts of antigens 
with antibodies of the cyberphysical immunosensory system on a rectangular lattice using delayed differential equations with the help of the 
packet R. The computer program "Computer simulation of antigen-antibody contacts in cyberphysical immunosensory systems on a rectangular 
lattice using delayed differential equations" was implemented. The computer modelling of the studied model is carried out, the parameters of the 
model, their numerical values are given, as well as the parameters in the package R. The latest researches in the field of immunosensors, their 
types, and the popularity of scientific research areas have been analysed in recent years. Despite the huge variety of modern physic-chemical 
methods of detecting the analytical signal in immunoassay, electrochemical methods are widely used, with a number of undeniable advantages: 
high sensitivity and accuracy, selectivity and expressiveness, not high cost and versatility. The package R is described as a programming 
environment for statistical analysis of data with given values of parameters of a immunosensor model on a rectangular lattice using delayed 
differential equations. The links to useful sites and guidelines for working with package R. The results of numerical modelling of antibody 
antigens contacts in cyberphysical immunosensory systems on a rectangular lattice using delayed differential equations allow us to conduct a 
study of the stability of a model of an immunosensor. It is established that its qualitative behaviour essentially depends on the time of delay. 

Key words: cyber-physical system, biosensor, immunosensor, mathematical model, differential equations, packet R. 
 

Вступ. Кібер-фізична система (КФС) – фізична система, яка реалізує інтеграцію обчислень та 
фізичних процесів. Вони відбуваються найчастіше у вигляді вбудованих систем та мереж для моніторингу 
та контролю фізичних процесів в системах зі зворотнім зв’язком. У таких системах динаміка фізичних 
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процесів є джерелом інформації досліджуваного явища з можливістю контролю та розрахунку сигналів 
керування об’єктом [1].  

Кібер-фізичні системи ототожнюються з проявом четвертої промислової революції, яка 
відбувається в сучасному світі [2]. Таким чином, існує також фізична можливість використання технологій 
“Internet of Things (Інтернет речей)”, де необхідно використовувати сигнали від давачів і вимірювальних 
приладів. Таким чином, в літературі з’являється все більше публікацій [3], які привертають увагу до 
сучасних концепцій та пропонують нові інноваційні рішення. А. Платцер запропонував підхід на основі 
“динамічної логіки”, де описано та проаналізовані кібер-фізичні системи [4]. В цих роботах 
використовуються гібридні програми (ГП) на простій мові програмування з простою семантикою. ГП дають 
змогу програмісту звертатись безпосередньо до дійсних значень змінних, які представляють реальні 
величини і визначають їх динаміку. 

Мета дослідження. Провести комп’ютерне моделювання контактів антигенів з антитілами в 
кіберфізичних імуносенсорних системах на прямокутній решітці з використанням диференціальних рівнянь 
із запізненням. 

Аналіз останніх досліджень. Важливим етапом проектування КФС є створення їх математичних 
моделей, які б адекватно відображали важливі, з точки зору задач дослідження, сторони просторово-часової 
структури імуносенсорів (рис. 1).  

 

 
Рис. 1. Етапи розробки та створення кіберфізичних систем медико-біологічних процесів 

 
Якість математичної моделі імуносенсора суттєво визначає ефективність методів його обробки в 

КФС, зумовлює рівень інформативності та репрезентативності діагностичних ознак, та зумовлює структуру 
програмної та апаратної складових проектованої інформаційної системи. 

Імуносенсори відносяться до аналітичних пристроїв для якісного і кількісного аналізу біологічних 
компонентів дослідних зразків, які засновані на виявленні специфічних антигенів та антитіл за допомогою 
імунокомплексів.  

Імуносенсори, що розробляються і розроблені до теперішнього часу, як правило, використовують 
гетерогенний формат імуноаналізу. Ґрунтуючись на характері механізму детектування, імуносенсори 
можуть бути розділені на електрохімічні, оптичні, п'єзоелектричні та інші. Для кожного типу характерні 
певні переваги і недоліки, що призводить до великої кількості досліджень під час розробки імуносенсорів 
[5]. 

Незважаючи на величезну різноманітність сучасних фізико-хімічних методів детектування 
аналітичного сигналу в імуноаналізі переважають електрохімічні методи, які мають низку незаперечних 
переваг: висока чутливість і точність (завдяки унікальному поєднанню специфічної взаємодії антиген-
антитіл і чутливої електрохімічної детекції), селективність і експресність, не висока собівартість та 
універсальність. 

Слід зазначити, що основним компонентом всіх імуносенсорів є рецепторний шар, що представляє 
собою антигени, моно-поліклональні антитіла, або їх фрагменти, певним чином нанесені на робочу 
поверхню трансдьюсера. Одна з проблем, пов'язана з ефективністю сендвіч-аналізу, на основі антитіл, 
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полягає в можливості взаємодії не тільки з визначеними антитілами, а й іншими імуноглобулінами, що 
утворюються при різніх системних захворюваннях. Ці білки знаходяться в 40% сироватки здорових 
пацієнтів і можуть призводити до хибних позитивних результатів аналізу. У пошуках альтернативних 
антитіл застосовують фрагменти антитіл, аптамери і білкові каркаси неімуноглобулінів [6–8]. Альтернативні 
молекули повинні задовольняти ряду вимог, а саме: їх необхідно швидко і недорого виготовляти, повинні 
бути стабільні в різних умовах, мати тривалий термін зберігання. При цьому «замінники» антитіл повинні 
володіти необхідною чутливістю і специфічністю [9]. Фрагменти антитіл, що володіють високою 
специфічністю для їх цільового аналіту, здатністю підтримувати розпізнавання антигену, невеликими 
розміри, в порівнянні з повним антитілом, більш застосовні для іммобілізації, ніж наявні природно 
сформовані антитіла, і стають важливими інструментами в дослідженні і створенні імуносенсорів [10]. Для 
іммобілізації біорецепторів в імуносенсорах застосовують методи, які використовуються при розробці 
біосенсорів.  

У роботі [11] проведено порівняльний аналіз електрохімічних імуносенсорів з іммобілізованими 
антитілами чотирма різними способами (фізичної сорбції, ковалентного зв'язування з застосуванням 
глутарового альдегіду, ковалентного зв'язування з застосуванням IgG людини і протеїну А). Проведені 
випробування показали, що найкращими аналітичними характеристиками володіє останній тип сенсорів. 

В ідеалі імуносенсор повинен бути багаторазовим пристроєм, оскільки оборотність взаємодії 
антиген-антитіло може дозволити регенерувати іммобілізований компонент. Однак висока константа 
афінності і проблема часто необхідних досить «суворих» умов іммобілізації антитіла або антигену, роблять 
регенерацію поверхні важкою для реалізації, тим самим обмежуючи практичне застосування імуносенсорів 
[12]. 

Пакет R як середовище програмування для статистичного аналізу даних та дослідження 
кіберфізичних імуносенсорних систем 

Пакет R – це середовище програмування для статистичного аналізу даних, яке  складається з базової 
програми R та окремих пакетів, які реалізують спеціальні методи та технології статистичної обробки даних. 
Програма R є некомерційною і вільно розповсюджується за умови дотримання вимог GNU General Public 
License [13]. 

R застосовується скрізь, де потрібна робота з даними. Це не тільки статистика в вузькому сенсі 
слова, а й «первинний» аналіз (графіки, таблиці спряженості), а також сучасне математичне моделювання. 
Дана програма також використовується як альтернатива комерційним програмним середовищам аналізу 
даних рівня MatLab / Octave. аналізі: від обчислення середніх величин до вейвлет-перетворень тимчасових 
рядів. 

Додаткової популярності R дало створення системи зберігання і розповсюдження пакетів – CRAN 
(Comprehensive R Archive Network — http://cran.r-project.org) [14]. Статистичні алгоритми зазвичай 
виконуються у вигляді скриптів і зібрані у пакети (packages) R. Під час інсталяції разом з базовою 
програмою інсталюються й основні пакети, у яких реалізовано найбільш популярні методи статистичного 
аналізу. Частина цих пакетів автоматично завантажується під час запуску R. Інші пакети можна 
завантажити, використовуючи функцію library. 

Переваги пакета R : 
• пакет R є вільнопоширюваним програмним забезпеченням (можна безкоштовно завантажити з 

сайту http://www.r-project.org); 
• є реалізації під операційні системи Microsoft Windows, Mac OS X, Linux; 
• базова комплектація R займає небагато місця на диску і містить всі функції, необхідні для 

проведення статистичного аналізу; 
• завжди можна додатково встановити допоміжні пакети; 
• хороша графічна візуалізація подання даних та результатів їхнього аналізу; 
• можливість самостійного написання необхідних функцій. 
Робота з пакетом R 
Після відкриття програми пакет R x64 3.5.2 з’являється головна сторінка програми (рис. 2).  
У верхній частині вікна знаходиться головне меню, а нижче відкрито вікно «консолі  R», в якій 

можна давати інструкції програмі та отримувати її відповіді. На рис. 3 виведено початкову інформацію про 
версію базової програми R.  

Під час роботи з R можна виконувати одразу багато інструкцій, що записані в окремому файлі. 
Найпростіший спосіб зробити – це завантажити такий файл в якому-небудь текстовому редакторі, 
скопіювати, а потім вставити на консолі. При цьому, якщо інструкції у файлі розміщені у окремих рядках, 
розділових знаків між ними не потрібно. Інструкції, вміщені в одному рядку, розділяють символом «;». 
Якщо довга інструкція не вміщується у одному рядку, її можна розбити на декілька рядів, причому, при 
переході до наступного рядка  R  автоматично  виводить символ продовження «+». R сам здогадується, що 
інструкція не закінчена за її синтаксисом. Тому деякі синтаксичні помилки (як-от забуті дужки) можуть 
сприйматись як незакінчені інструкції. У цьому випадку R присвоїть + на початку наступного рядка і 
перейде у режим очікування. Натиснувши Еscape можна перейти у режим введення нової інструкції без 
продовження аналізу попередньої. Програми, що складаються з інструкцій R, називають скриптами (script). 
Вони мають стандартне розширення .r.  У базовій програмі є можливість відкрити вікно редактора для 
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створення нового скрипту, або завантажити файл зі скриптом, використовуючи пункти головного меню  
File->Newscript або File->Openscript. Виконати завантажений у вікні редактора скрипт повністю можна, 
використовуючи  Edit->Runall. 

 

 
Рис. 2. Головна сторінка програми програми пакету R x64 3.5.2. 

 
Зберегти скрипт можна за допомогою команди File->Save. 
Пакети в R 
Одна з важливих переваг R – наявність для нього різноманітних розширень або пакетів, які 

реалізують найбільш популярні технології статистичної обробки [15]. Частина цих пакетів автоматично 
завантажується при запуску R.  

Якщо потрібний пакет не було інстальовано на комп’ютері, його можна завантажити з інтернет-
архіву, використовуючи пункти головного меню Packages->Installpackage(s). Спочатку програма пропонує 
вибрати інтернет-архів, з якого робиться інсталяція. Варіант 0-cloud, що пропонується за замовчуванням, як 
правило, працює цілком задовільно. Після цього потрібно у списку вибрати необхідний пакет. Якщо цей 
пакет використовує інші пакети R, яких немає на комп’ютері, вони будуть інстальовані автоматично. 

Після того, як пакети інстальовані, вони зберігаються на комп’ютері, але для роботи з ними під час 
сеансу їх необхідно підключати, використовуючи функцію library. Усі об’єкти, створені або завантажені під 
час сеансу роботи з R і не видалені спеціальною інструкцією, зберігаються у робочому просторі. Наприкінці 
сеансу R запитує, чи зберігати робочий простір на диску: «Save workspace image?». Якщо вибрати 
збереження, то цей робочий простір буде відновлено на початку наступного  сеансу. Зберігати робочий 
простір доцільно лише в тому випадку, коли є необхідність наступного разу продовжити роботу з того 
самого місця, на якому була закінчена робота попереднього разу. 

Корисні сайти, списки посилань і документація по пакету R 
http://www.r-project.org/ — сайт проекту; 
http://cran.r-project.org/ — CRAN; 
https://stat.ethz.ch/pipermail/r-help/ — список посилань R-help; 
http://finzi.psych.upenn.edu/nmz.html — пошук в матеріалах по R; 
http://www.statmethods.net/index.html — хороший довідник ресурс; 
http://zoonek2.free.fr/UNIX/48_R/all.html — довідник по R; 
http://pj.freefaculty.org/R/Rtips.html — поради по використанні R. 
 
Результати чисельного моделювання імуносенсора на прямокутній решітці у вигляді фазових 

площин. 
З метою отримання результатів чисельного моделювання кіберфізичних імуносенсорних системах 

на прямокутній решітці з використанням диференціальних рівнянь із запізненням вводяться значення 
параметрів моделі імуносенсора на прямокутній решітці з використанням диференціальних рівнянь із 
запізненням. У комп’ютерній програмі «Комп'ютерне моделювання контактів антигенів з антитілами в 
кіберфізичних імуносенсорних системах на гексагональній решітці з використанням диференціальних 
рівнянь із запізненням» визначальними є параметри моделі, їх числові значення, а також представлення 
параметрів та їх числових значень в пакеті R, згідно з табл. 1. 
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Таблиця 1 

Значення параметрів моделі імуносенсора на прямокутній решітці  
з використанням диференціальних рівнянь із запізненням 

№ 
п/п 

Назва параметра моделі 
Числові значення 

параметрів 

Представлення параметрів 
та їх числових значень в 

пакеті R 
1.  Ціле натуральне число, яке характеризує 

кількість імунопікселів в прямокутній решітці 
4=N  N <- 16#4#16 

 
2.  Константа народжуваності  для популяції 

антигенів 
1min2 −=β  beta <- 2 

3.  Ймовірнісна швидкість нейтралізації антигенів 
антитілами; 

g

mL

μ
γ

⋅
=

min
2  

gamma <- 2 

4.  Стала смертності антитіл 1min1 −=fμ  mu_f <- 1 

5.  Щільність антигенів γη /8.0=  etha <- 0.8/gamma     
#0.01184/gamma 

6.  Швидкість, з якою популяція антигенів прагне 
до деякої межі насичення 

g

mL

μ
δυ ⋅

=
min

5.0  
delta_v <-  0.5  #0.035 #0.7 

7.  Швидкість, з якою популяція антитіл прагне 
до деякої межі насичення 

g

mL
f μ

δ
⋅

=
min

5.0  
delta_f <-  0.5  #0.0175 #0.2 

8.  Постійна запізнення в часі, з якою настає 
імунна відповідь 

0.05=τ , 

0.22=τ , 

0.23=τ  

0.2865=τ  

tau <- 
0.05#0.22#0.23#0.2865 

9.  Коефіцієнт дифузії 

min
2.0

2nm
D =  

D <- 0.2 

10.  Відстань між пікселями nm3.0=Δ  Delta <- 0.3 

11.  Стала дисбалансу 0>n  n <- 0.9 #1. 

12.  Коефіцієнт пропорційності інтенсивності 
флуоресценції до кількості контактів між 
антигенами та антитілами 

flk  k_fl <- 1 

13.  Порогове значення, що визначає перехід до 
стану флуоресценції в біопікселі 

flΘ  fluorescence_intensity_thres
hold <- 1.5 

 
Після введення відповідних значень параметрів моделі імуносенсора на прямокутній решітці з 

використанням диференціальних рівнянь із запізненням, згідно з табл. 1, представлення в пакеті R x64 3.5.2 
отримаємо у вигляді рис. 3. 

На рисунку 2 також наведено результат введення математичної моделі імуносенсора на прямокутній 
решітці з використанням диференціальних рівнянь, яка має вигляд 

{ }

)())()((
)(

)())()((
)(

,,,
,

,,,,
,

tFtFtV
dt

tdF

VStVtVtF
dt

tdV

jijifjif
ji

jijijiji
ji

δτηγμ

τδτγβ υ

−−+−=

+−−−−=
∧

.   (1) 

На даному етапі комп’ютерного моделювання моделі імуносенсора було використано решітчасті 
графіки. Спершу побудовано відповідні графіки, на яких для кожного пікселя представлено ймовірність 

контакту антигенів з антитілами, як kjikji FV ,,,, ×  при 05.0=τ , 22.0=τ , 23.0=τ , 2865.0=τ , 

представлені на рис. 3(а–г). 
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Рис. 3. Представлення в пакеті R x64 3.5.2 математичної моделі імуносенсора на прямокутній решітці з використанням 

диференціальних рівнянь із запізненням та відповідних параметрів, згідно з табл. 1 
 

 
а) 

 
б) 

   
в) 

Рис. 4. Решітчасті зображення зав’язків антигенів з антитілами в пікселях системи (1)  

при 05.0=τ ; (а), 22.0=τ  (б), 23=τ  (в), 2865.0=τ  (г) 
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г) 

Рис. 4. Решітчасті зображення зав’язків антигенів з антитілами в пікселях системи (1)  

при 05.0=τ ; (а), 22.0=τ  (б), 23=τ  (в), 2865.0=τ  (г) (продовження) 

 
Згідно з рис. 3(а-г) спостерігаємо, що при зміні значення τ  змінюється якісна поведінка пікселів та 

всього імуносенсора. Наприклад, при ]22.0,0[∈τ  бачимо траєкторію, що відповідає стійкому вузлу для 

всіх пікселів (рис. 3(а, б)). 
При значенні τ  близьких до .23.0 хв  виникає біфуркація Хопфа та подальші траєкторії 

відповідають стійким граничним циклам еліпсоподібної форми для усіх пікселів (рис. 3(в) для 23.0=τ ). 
Для значень 27.0>τ  спостерігаємо хаотичну поведінку (рис. 3г). 

Детальний опис математичної моделі імуносенсора на прямокутній решітці з використанням 
диференціальних рівнянь із запізненням представлено в роботах [17–20]. 

Фрагмент лістингу комп’ютерної програми «Комп'ютерне моделювання контактів антигенів з 
антитілами в кіберфізичних імуносенсорних системах на прямокутній решітці з використанням 
диференціальних рівнянь із запізненням» 
  #------------------------------- 
  # tile plot for dynamic changes of pixels 
  #------------------------------- 
  increment = times[2]-times[1] 
  for(i in seq(1,round(max(times)/increment),by=round(max(times)/(100*increment)))) 
  { 
    V_tile<-yout[i,2:(N*N+1)] 
    F_tile<-yout[i,(N*N+2):(2*N*N+1)] 
 
    time = yout[i,1] 
    biosensor_matrix_V_tile.data <- data.frame(V_tile,index_i,index_j) 
    biosensor_matrix_F_tile.data <- data.frame(F_tile,index_i,index_j) 
    biosensor_matrix_V_tile <- ggplot(biosensor_matrix_V_tile.data, aes(x=index_i,y=index_j)) + 
ggtitle(paste("V time=",time,sep="")) 
    
dir.create(file.path(paste("D:/My_doc/Sverstiuk/Biosensors/Imunosensory/Plots6_CyberPhysical/", 
paste("Tau",tau,sep=""),sep=""),"V_matrix"), showWarnings = FALSE) 
    setwd(file.path(paste("D:/My_doc/Sverstiuk/Biosensors/Imunosensory/Plots6_CyberPhysical/", 
paste("Tau",tau,sep=""),sep=""),"V_matrix")) 
    png(paste(paste("Tau",tau,"time",time,"_Matrix_V",sep=""),"png",sep="."), width = 800, height 
= 600) 
    biosensor_matrix_V_tile <- biosensor_matrix_V_tile + geom_tile(aes(fill=V_tile)) 
    biosensor_matrix_V_tile <- biosensor_matrix_V_tile + scale_fill_gradientn(colours = 
terrain.colors(10)) + theme_set(theme_bw(base_size=28)) 
    print(biosensor_matrix_V_tile) 
    dev.off() 
    biosensor_matrix_F_tile <- ggplot(biosensor_matrix_F_tile.data, aes(x=index_i,y=index_j)) + 
ggtitle(paste("F time=",time,sep="")) 
    
dir.create(file.path(paste("D:/My_doc/Sverstiuk/Biosensors/Imunosensory/Plots6_CyberPhysical/", 
paste("Tau",tau,sep=""),sep=""),"F_matrix"), showWarnings = FALSE) 
    setwd(file.path(paste("D:/My_doc/Sverstiuk/Biosensors/Imunosensory/Plots6_CyberPhysical/", 
paste("Tau",tau,sep=""),sep=""),"F_matrix")) 
    png(paste(paste("Tau",tau,"time",time,"_Matrix_F",sep=""),"png",sep="."), width = 800, height 
= 600) 
    biosensor_matrix_F_tile <- biosensor_matrix_F_tile + geom_tile(aes(fill=F_tile)) 
    biosensor_matrix_F_tile <- biosensor_matrix_F_tile + scale_fill_gradientn(colours = 
terrain.colors(10)) + theme_set(theme_bw(base_size=28)) 
    print(biosensor_matrix_F_tile) 
    dev.off() 
  } 

Висновок. Описано пакет R як середовище програмування для статистичного аналізу даних, 
представлено фрагмент роботи з досліджуваним пакетом, наведені посилання на корисні сайти, списки 
посилань і документація по пакету R. В роботі проведено комп'ютерне моделювання контактів антигенів з 
антитілами в кіберфізичних імуносенсорних системах на прямокутній решітці з використанням 
диференціальних рівнянь із запізненням за допомогою пакету R. Отримані результати мають визначальне 
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значення при дослідженні стійкості моделі імуносенсора. При цьому враховується наявність колоній 
антигенів та антитіл, що локалізовані у пікселях, а також дифузія колоній антигенів між пікселями. 
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